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About This Guide

This document is intended to help users set up the basic software development environment
for developing app using hardware based on the T-Display-S3-AMOLED 1.43.
Through a simple example, this document illustrates how to use Arduino, including the

menu based configuration wizard, compiling the Arduino and firmware download to the
ESP32-S3 module.

Release Notes

Date Version Release notes

2024.12 V1.0 First release.



Table of Contents

BRI 1010 T [ T T o T 1
1.1, T-Display-S3-AMOLED 1.43. ... ... oottt et et e et e e e ee e e et eee et eeeeneeeeeeeeeeneneenanes 1
1.2, ATAUINO e e e e e e e e et e e e e et e e e e et eeeeeeaeeeeeeeenneeeeeaneeeeeanneeeeeaennaeeeaannes 1
LI TR o (= 0 Y= U= 1 o) PSP 1

R 1= S 7= g (Vo IR 2
2.1. Download the ArdUiNO SOfIWEAIE .............cooiieeeeee e e e e e et e e e e e eeeeeeareeeeeeeeaas 2

P2 P T [ 1= = 1 =Y =T [0S =T 2
2.1.2. TOOICNAIN SELUD oo eee e nnnnnnn 2
2.2, Install the ArdUiNO SOTIWAIE ... .........ooo oot e e e e e et e e et e e e e e e e e e e eaneeseneeeneens 3
P2 T 1= U o N - 1 1 o SRR 3

c CONFIGUIE e 4

R 7o) 010 1=1 o1 STTTRTTT TR 5

B =TS O B 7= 1 4T TR 6

L o] 0T T IS =] (o] IO 7
LT I = 10 1T 1= T I = 1= o TN 7
T2 Ve o 1 (o 8
SSC COMMANA REIEIEINCE ... e e e e e e e e e e eaaaen 9
7470 S o ] o PP 9
%2 < - T 9
7220 TR - o TP 10
28 S o 0T~ T 10
7455 TR o | Vo7 o SRS RSSPRSRSPRIN 11
7450 T T YRS 11
8 P (=Y Y T ) 12

228 < TR =T o o 12



1. Introduction

1. Introduction

1.1. T-Display-S3-AMOLED 1.43

T-Display-S3-AMOLED 1.43 is a development board. It can work independently.
It consists of ESP32-S3 MCU supporting Wi-Fi + BLE communication protocol and
motherboard PCB. The screen is 1.43 inch AMOLED.

At the core of this module is the ESP32-S3-R8 chip.

ESP32-S3 integrates Wi-Fi (2.4 GHz band) and Bluetooth 5.0 solutions on a single chip,
along with dual high performance cores and many other versatile peripherals. Powered by
40 nm technology, ESP32-S3 provides a robust, highly integrated platform to meet the
continuous demands for efficient power usage, compact design, security, high performance,
and reliability.

Xinyuan provides the basic hardware and software resources that empowers application
developers to build their ideas around the ESP32-S3 series hardware. The software
development framework provided by Xinyuan is intended for rapidly developing Internet-of-
Things (loT) applications, with Wi-Fi, Bluetooth, flexible power management and other
advanced system features.

The T-Display-S3 AMOLED 1.43 manufacturer is Xin Yuan Electronic Technology Co., Ltd.

1.2. Arduino

A set of cross-platform applications written in Java. The Arduino Software IDE is derived
from the Processing programming language and the integrated development
environment of the Wiring program. Users can develop applications in Windows/Linux/
MacOS based on Arduino. It is recommended to use Windows 10. Windows OS has
been used as an example in this document for illustration purposes.

1.3. Preparation
To develop applications for ESP32-S3 you need:
e PC loaded with either Windows, Linux or Mac operating system
¢ Toolchain to build the Application for ESP32-S3
¢ Arduino that essentially contains API for ESP32-S3 and scripts to operate the Toolchain

e The ESP32-S3 board itself and a USB cable to connect it to the PC

Xinyuan 1/12 2024.12



2. Get Started

2. Get Started

2.1. Download the Arduino Software

The quickest how to install the Arduino Software (IDE) on Windows machines

2.1.1. Quick Start Guide
The website provides a quick start tutorial

e Windows:

‘ https.//www.arduino.cc/en/Guide/Windows

e Linux:

‘ https://www.arduino.cc/en/Guide/Linux

e Mac OS X:

‘ https://www.arduino.cc/en/Guide/MacOSX

2.1.2. Installation steps for Windows platform Arduino

Genuino

ARDUINO

Search the Arduino Website Q

Home Buy Download Products -~ Learning -~ Forum Support »~ Blog LOGIN SIGN UP

DOWNLDAD
Download the Arduino Software

Windows installer
Windows ZIP file for non admin install

ARDUINO 1.8.1 Windows app| Get i3
The open-source Arduino Software (IDE) makes it easy to .
write code and upload it to the board. It runs on Mac OS X 10.7 Lion or newer
Windows, Mac OS X, and Linux. The envircnment is
% written in Java and based on Precessing and other open- &
saurce software, Linux 32 bits
This software can be used with any Arduino board. Linux 64 bits
Refer to the Getting Started page for Installation Linux ARM
instructions.

Release Notes
Source Code
Checksums (sha512)

Try out the new
Connect, Collaborate, Create. Learn more about the Create platform.

Arduino Web Editor

Enter the download interface, select Windows installer to install directly
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https://www.arduino.cc/en/Guide/Windows
https://www.arduino.cc/en/Guide/Linux
https://www.arduino.cc/en/Guide/MacOSX

2. Get Started

2.2. Install the Arduino Software

@ Arduine Setup: Installation Options — =

.:: Check the components you want to install and uncheck the components

you don't want to install. Click Next to continue.

Select components to install: Install Arduino software
Install USE driver

Create Start Menu shortout
Create Desktop shortout

Assodate .ino files

Space reguired: 392, TMB

Cancel | Mullsoft Install System v2, 46 < Back Mext =

@ Arduine Setup: Installing

W Extract: ct++.exe
.CE’ I

Zancel | Mullsaft Install Sywstem w246

Wait for installation
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3. Start a Project

3. Configure

3.1. Download Git

Download the installation package Git.exe

.

o glt --distributed-even-if-your-workflow-isnt Q Search entire site...
About
IRt Downloads
nsnkoads Latest source Release

GUI Clients

Logos @ pacosx ¥ windows _2'21'? .

F =s (2019-02-24;

U 0 Linux/Unix Download 2.21.0 for Windows

Older releases are available and the Git source

repository is on GitHub.

The entire Pro Git book
written by Seott Chacon and
Ben Straub is available to read
online for free. Dead tree
versions are available on GUI Clients Logos
Amazon.com.

Git comes with built-in GUI tools (git-gud, Various Git logos in PNG (bitmap} and EPS
gitk). but there are several third-party tools for (vector) formats are available for use in
users looking for a platform-specific online and print projects.

experience.

View Logos —
View GUI Clients —

Git via Git

If you already have Git installed, you can get the latest development version via Git itself:

git clone httpa://github.com/git/git

You can also always browse the current contents of the git repository using the web interface.

3.2. Pre-build configuration
Click Arduino icon, then right click and select Open folder where
Select hardware ->
Mouse Rightclick ->

Click Git Bash Here

3.3. Cloning a remote repository

% mkdir espressif
% cd espressif

% git clone --recursive https://github.com/espressif/arduino-esp32-git esp3e
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4. Connect

Connect

You are almost there. To be able to proceed further, connect ESP32-S3 board to PC,
check under what serial port the board is visible and verify if serial communication works.

1.Connect the USB

2.The screen displays “E-Label” for 5 seconds.

N\

,/
CEFEC 2

FCCID: 2ASYE-TDISS3-AMOLED

Er211-250112
MODEL:T-Display-S3-AMOLED 1.43

AMOLED 1.43

Xinyuan

FCC ID: 2ASYE-TDISS3-AMOLED

@\R 211-250112

MODEL:T-Display-S3-AMOLED 1.75

AMOLED 1.75

5/12

FCCID: 2ASYE-TDISS3-AMOLED

Er211-250112

MODEL:T-Display-S3-AMOLED
1.75 hemispherical

AMOLED 1.75 hemispherical

2024.12



4. Configure

. Test Demo

Select File>s>Example>>WiFi>>WiFiScan

File Edit Sketch Tools Help

New Ctrl+N

Open... Ctrl+0

Open Recent *

Sketchbook >

Examples : F

Close Cirl+W SE z

Save Cirl+S SPIFES 2

Save As..  Ctrl+Shift+5 ficker *
Update >

Page Setup  Ctrl+Shift+P WebSaer 5

Print Ctrl+P WiE ETH LANS720

Plaforencas ChliComma WiFiClientSecure ETH_LANS720_internal_clock

Quit Cirl+Q) Examples from Custom Libraries ET:;T:;:?EWW

~ WIFI CVEIILS Accelerometer ADXL345 S :
ACROBOTIC $5D1306 Wibo bt
ACS713 Current Sensor WiFiBlueToothSwitch
WiFiClient

ADOB50-master

Adafruit ADXL345

Adafruit APDS9960 Library
Adafruit BME280 Library

WiFiClientBasic
'WiFiClientEnterprise
WiFiClientEvents

2 : : WiFiClientStaticlp
Adafruit BMPO8S Library
A . : WiFiIPv6
3 Adafruit BMP280 Library 4 :
5 , WiFiMulti
Adafruit DotStar 2 T
; e I G
=5 Adafruit DotStarMatrix = LEed Al
: WiFiSmartConfig
o Adafruit EPD i A
2 ; WiFiTelnetToSerial 1 3]
Adafruit 1LI9341 ‘
- WiFiUDPClient
(8 Adafruit ImageReader Library £ 5 1 b

Adafruit INA219

Adafruit MLX90614 Library
Adafruit MPL3115A2 Library
Adafruit MPR121

Adafruit NeoPixel
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5. Build and Flash

6. Upload Sketch

6.1. Select Board
Tools -> Board -> ESP32S3 Dev Module

6.2. Upload
Sketch -> Upload
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6.2. Serial Monitor

Tools ->Serial Monitor

B CoMd
|

scan start

scan done

2 networks found

1: MEO-620B4B (-39} *
2: MEO-WiFi (-39)

scan start

scan done

2 networks found

1: MEO-620B4B (-38)*
2:; MEO-WiFi (-38)

] Autescrol

Xinyuan
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5. Build and Flash
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6. SSC Command Reference

SSC Command Reference

Here lists some common Wi-Fi commands for you to test the module.

71. op
Description
op commands are used to set and query the Wi-Fi mode of the system.
Example
op -Q
op -S -o wmode
Parameter
Table 6-1. op Command Parameter
Parameter Description
-Q Query Wi-Fi mode.
-S Set Wi-Fi mode.
There are 3 Wi-Fi modes:
® mode = 1: STA mode
wmode
® mode = 2: AP mode
® mode = 3: STA+AP mode
7.2. sta
Description

sta commands are used to scan the STA network interface, connect or disconnect AP, and
query the connecting status of STA network interface.

Example

sta -S [-s ssid] [-b bssid] [-n channel] [-h]
sta -Q

sta -C [-s ssid] [-p password]

Xinyuan

sta -D
Parameter
Table 6-2. sta Command Parameter
Parameter Description
-S scan Scan Access Points.

9/12 2024.12




6. SSC Command Reference

-s ssid Scan or connect Access Points with the ssid.
-b bssid Scan the Access Points with the bssid.
-n channel Scan the channel.
-h Show scan results with hidden ssid Access Points.
-Q Show STA connect stutus.
-D Disconnected with current Access Points.
7.3. ap
Description
ap commands are used to set the parameter of AP network interface.
Example
ap -S [-s ssid] [-p password] [-t encrypt] [-n channel] [-h] [-m max_sta]
ap —Q
ap —L
Parameter
Table 6-3. ap Command Parameter
-S Set AP mode.
-s ssid Set AP ssid.
-p password Set AP password.
-t encrypt Set AP encrypt mode.
-h Hide ssid.
-m max_sta Set AP max connections.
-Q Show AP parameters.
-L Show MAC Address and IP Address of the connected station.
7.4. mac
Description

mac commands are used to query the MAC address of the network interface.

Example

Xinyuan

mac -Q [-o mode]
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6. SSC Command Reference

Parameter

Table 6-4. mac Command Parameter

-Q Show MAC address.

® mode = 1: MAC address in STA mode.
® mode = 2: MAC address in AP mode.

-0 mode

7.5. dhcp

Description
dhcp commands are used to enable or disable dhcp server/client.

Example

dchp -S [-0 mode]
dhcp -E [-0 mode]

dhcp -Q [-0 mode]

7.6.

ip

Parameter

Table 6-5. dhcp Command Parameter

-S Start DHCP (Client/Server).
-E End DHCP (Client/Server).
-Q show DHCP status.

® mode = 1: DHCP client of STA interface.
-0 mode ® mode = 2 : DHCP server of AP interface.
® mode = 3 : both.

Description
ip command are used to set and query the IP address of the network interface.

Example

Xinyuan

ip -Q [-o mode]

ip -S [-1 ip] [-o mode] [-m mask] [-g gateway]
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6. SSC Command Reference

Parameter
Table 6-6. ip Command Parameter
Parameter Description
-Q Show IP address.
® mode = 1 : IP address of interface STA.
-0 mode ® mode =2 : IP address of interface AP.
® mode = 3 : both
-S Set IP address.
-iip IP address.
-m mask Subnet address mask.
-g gateway Default gateway.
7.7. reboot
Description
reboot command is used to reboot the board.
Example
reboot
7.8. ram

ram command is used to query the size of the remaining heap in the system.

Example

ram

Xinyuan
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FCC Caution:

Any Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired

operation.

This transmitter must not be co-located or operating in conjunction with any other antenna

or transmitter.

IMPORTANT NOTE:

Note: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

—Reorient or relocate the receiving antenna.

—Increase the separation between the equipment and receiver.

—Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

—Consult the dealer or an experienced radio/TV technician for help.

FCC Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an
uncontrolled environment .This equipment should be installed and operated with

minimum distance 20cm between the radiator& your body.
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